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INTRODUCTION TO QGIS 

1 INTRODUCTION 
This guide provides a quick introduction to QGIS. No prior knowledge of GIS concepts or in using the QGIS 
software is needed. Th purpose of this workshop is for participants to become familiar with QGIS and learn how 
to quickly get started with the software. Specifically, you will learn:  

• how to bring in various basemaps as well as accessing public web map services,  
• extend the core capabilities of QGIS with plugins,  
• view, edit, and symbolize vector spatial data 
• create spatial data from text file 
• view and work with raster data 
• derive a normalized digital elevation model 
• reproject data from one coordinate system to another 
• extract information from one layer to another by performing zonal statistic 
• display/extrude features to 3D 
• how to make a basic map for print and the web 

QGIS is a great application to start learning GIS with.  There is no licensing cost which makes it accessible to 
everyone.  

2 WHAT IS QGIS 
QGIS (formerly known as Quantum GIS) is a free, opensource, cross platform desktop GIS software that supports 
viewing, editing, and analyzing spatial data. Opensource GIS is also known as FOSS4G or Free and Open Source 
Software for Geospatial. The term opensource is used to denote software in which the source code is open and 
made publicly available and is free to use, modify and distribute. 

QGIS integrates well with other opensource GIS packages such as PostgreSQL/PostGIS, GRASS, R, SAGA, and 
many others. In addition, there are various plugins that can extend QGIS’s core capabilities.  

QGIS has a large community of users and volunteer developers who maintain it and continues to release new 
features and bug fixes on a regular basis.  More information can be found on QGIS webiste. 

3 INSTALLING QGIS 
To install QGIS, go to the QGIS website and download the version for your platform. For Windows OS there are 
two ways to install QGIS: the standalone installer or the OSGeo4W Network installer. For beginners, I 
recommend the standalone installer. The OSGeoW4 installer is geared toward more advanced users who are 
familiar with different  

The installer will install the latest release, which is version of QGIS 3.16 Hanover which just came out on October 
23rd, 2020. A stable, long term release (LTR) version 3.10.11 is also available.  

https://opengislab.com
https://www.qgis.org/en/site/forusers/index.html
https://www.qgis.org/en/site/forusers/download.html
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1. Download the installer for your platform 
2. Start the setup wizard (double click installer file you downloaded) 
3. Agree to license usage agreements 
4. For destination folder, leave as the default 
5. Option to download sample datasets – no need to download since we will not be using for this 

workshop 
6. Click Install 

4 DOWNLOAD WORKSHOP DATA 
Download dataset for workshop:  QGIS_Workshop_Data.zip. This link will expire November 27th, 2020. 

The zipped file contains 4 folders as seen below: 

 

The data used for the workshop are listed in the table below. Note that some data have been modified to meet 
the pedagogical needs of this workshop. The dataset should not be used outside of this workshop. The Solutions 
folders contains backup files for the workshop exercises. 
 

Filename Description Source Coordinate System 
UHM_BldgsFP.shp Building Footprints of 

UH Manoa 
UHM OSI  EPSG:3760 - 

NAD83(HARN) / Hawaii 
zone 3 (ftUS) 

UHM_DSM Digital Surface Model Hawaii Statewide GIS 
Program 

EPSG:3750 - 
NAD83(HARN) / UTM 
zone 4N 

UHM_DTM Digital Terrain Model Hawaii Statewide GIS 
Program 

EPSG:3750 - 
NAD83(HARN) / UTM 
zone 4N 

Campus_Trees_Rock1920.txt Text files with Lat/Long 
of campus trees planted 
by Joseph Rock 1920 

UHM OSI Latitude, Longitude 
(WGS 84) 

opengislablogo.png Logo image  Stephanie Saephan Not applicable 
 

5 SPATIAL DATA MODEL, TYPE, AND FORMATS 
Spatial data model consists of 2 parts: feature geometry and attributes. The geometry or shape is defined using 
a pair of real-world coordinates (x,y) and its properties or attributes is define with data and data types (e.g. 
information about the geometry). 

https://opengislab.com
https://1drv.ms/u/s!ApweUs3ribupiYkRRvb0wqwvaXdbcg?e=4XlC4t


   

3 

Spatial data can be categorized into 2 main types: Raster and Vector. Vector data is when geographic features 
and spatial phenomenon are represented as points, lines, or polygons. Raster data format is when geographic 
features and spatial phenomenon are represented as a grid of cells. Each cell contains a single attribute value 
and its location (XY) is defined by its place (row and column) in the grid. 

Spatial data can come in various formats, some are tabular and non-spatial and others are spatial and ready to 
use in GIS. Below are some examples. 

Format Non-Spatial Data Spatial Data (ready to use in GIS) 
Text csv, json, xml Kml, csv, geojson 
Binary/Compressed xlsx.zip, pdf Shapefile, geopdf, geopackage 
Images Tif, jpg, png Geotiff, jp2 
Databases SQLite, PostgreSQL Spatialite, PostGIS, GDB 

6 MAP PROJECTIONS AND COORDINATE REFERENCE SYSTEMS 
Coordinate Reference System (CRS) the spatial reference of a spatial dataset, and is what 
allows GIS to easily integrate datasets with different spatial references into a common spatial 
reference framework. There are two general types of coordinate systems: one is the global or spherical 
coordinate system, such as latitudes and longitudes, commonly referred to as geographic coordinate systems 
(GCS). The other is projected coordinate system (PCS), which is based on a map projection such as 
Transverse Mercator, Albers Equal Area, or Robinson; all of which provide various methods to project 
maps of the earth's spherical surface onto a two-dimensional Cartesian coordinate plane. These are 
sometimes referred to as map projections. 
 
CRS are specified by EPSG codes in QGIS. EPSG is an acronym for European Petroleum Survey Group, which 
publishes a database of coordinate systems and datums that is used as the open source standard. For more 
information on EPSG codes, see epsg.org. To find EPSG codes, see epsg.io to import/convert and ESRI *.prj 
(projection file) to an EPGS equivalent code. 

When you open a new QGIS project, it defaults to the global CRS of WGS84 or EPSG 4326, The first layer you add 
to the project will set the project’s CRS to that of the layer. The CRS is important to getting different data layers 
that may be in different projects to align with each other.  

Listed below is a list of commonly used CRS used in Hawaii. 

 

https://opengislab.com
https://epsg.org/home.html
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7 QGIS USER INTERFACE 
QGIS is used to make maps, edit data, and do GIS analyses. If you’re familiar with ArcGIS, QGIS works similar to 
ArcMap. 

Open QGIS on your computer. The graphical user interface (GUI) should look something like the image below. 
The main components of the GUI are shown. 

 

 
① Main Menu: Provides access to various features and functions of the application in a standard hierarchy 

menu style. The Main Menu cannot be moved unlike the toolbars and panels  
 
② Toolbars: Buttons that provide a one click access (i.e. shortcuts) to many of the features and functions found 

in the Main Menu. Toolbars are movable and can be docked or free floating. 
 
③ Browser Panel: shows a listing of files on your computer. You can drag and drop GIS files into the Layers 

Panel to view them. This panel is movable and can be hidden/shown on the GUI.  
 
④ Layer Panel: shows a listing of map layers that are in your current project. Layers can be turned on/off, 

grouped, change drawing order, etc. This panel is often also referred to as the Table of Contents (TOC). 
 
⑤ Map View Panel: shows a geographic display of GIS layers in the Layers Panel. 
 
⑥ Status Bar: shows the current scale of the map display, coordinates of the current mouse cursor position, 

and the coordinate reference system (CRS) of the project.  

https://opengislab.com
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The GUI can be customized. All the toolbars and panels can be docked or free floating. Many other aspects of 
the GUI can be configured via the Options windows in the Settings Menu. 

8 INSTALLING PLUGINS 
There are many plugins that can be installed to extend the core capabilities of QGIS. A very useful plugin is the 
QuickMapServices that lets you add several basemaps (e.g. Google imagery, OpenStreetmap). The steps in this 
section shows you how to install the plugin and use it to add Google aerial or other basemaps to QGIS.  

Note: Connection to Internet is needed for this portion since QGIS is fetching the plugin repository online. 

 INS TALLING  QUICKMAPSE RV ICE S  PLUG IN  
 

1. Go to Plugins Menu >> Manage and Install Plugins. Wait for QGIS to fetch the plugins. 
 

 
 

2. In the Plugins window: Search for QuickMapServices, select it then click Install Plugin. 

 
 
Wait for a message to say Plugin installed successfully. 
 
 

 

https://opengislab.com
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Optional Plugin Settings: You can also set QGIS to check for plugin updates on startup 

 

 CO NFIGURING  QUICKMAPSE RV ICES  PLUGIN 
 
The QuickMapServices tool can be found in the Web Menu or as a button on the Web Toolbar.  

 
To get access to more basemaps, such as Google imagery and ESRI basemaps you need to the add contributed 
packs.  
 

1. Go to Web Menu >> QuickMapServices >> Settings  
 
In the Setting window: 

• Go to More Service tab 
• Click Get Contribute Pack 
• Click OK to popup message 
• Click Visibility tab and check box to show/hide services 

https://opengislab.com
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• Save your setting options when done 
 

 
 

 

9 CONNECTING TO WEB SERVICES 
Many government agencies and organizations provide their data via public web services or on open geoportals. 
This section goes over how to connect to some of the public web services that you may find useful, such as the 
Hawaii Statewide GIS and the City and County of Honolulu. The connections only need to be made once in the in 

https://opengislab.com
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QGIS and will remain until you remove them. Once connections are made you can then add web services layers 
to your map.  
 
Web map services can be published over the web using several different protocols. For the purpose of this 
workshop, WMS (Web Map Service) and WFS (Web Feature Service) will be discussed. WMS is probably the best 
known standard due to its widespread use by map servers to deliver map images. WFS communicates 
geographic feature information, allowing features to be queried, updated, created, or deleted by the user. Many 
of these web mapping standards are set and maintained by the Open Geospatial Consortium (OGC).  
 
Hawaii Statewide GIS program and the City and County of Honolulu both use ESRI/ArcGIS software to offer two 
ways you can access these public web services: 1) via ArcGIS server REST services and 2) Geoportal. The REST 
services option is a lot quicker if you know what you’re looking for. The Geoportal provides a more user-friendly 
way to search for and preview data. The type of services available is set by the organization (viewing only, can 
change symbology, export, etc). 
 
Note: Connection to Internet is needed for this portion 

 CO NNE CTING TO ARCGIS WE B MAP SE RV ICES  (WMS, WFS) 
 
Connecting to the ParcelsZoning Map Server REST service 
 

1. Open up a web browser and go to the Hawaii Statewide GIS REST service link: 
http://geodata.hawaii.gov/arcgis/rest/services 
 
Under the list of Services, click on the ParcelsZoning (MapServer), then copy the URL link 

 
 

https://opengislab.com
https://www.ogc.org/docs/is
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2. In QGIS: in the Browser Panel >> Right click on ArcGIS Feature Service >> New Connection 
 
In the Connection window:  

• Type in a Name for the connection (e.g. Hawaii Statewide GIS – ParcelsZoning) 
• URL: paste in the URL you copied from step 1 
• No Authentication is needed since this is public service 
• Click OK to connect 

 

 

https://opengislab.com
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You should now see the connection to the ParcelsZoning web service you just created.  

 

3. Optional – Create a new ArcGIS Map Service connection using the same URL or a different URL to see 
the difference between a WMS and WFS protocol. 
 
Browser Panel >> Right click on ArcGIS Map Service >> New Connection 
 
Here is an example, showing the difference between a WMS (raster image) and WFS (vector feature 
polygons). Notice that with the WFS you can turn individual feature category on/off. 

 
 

4. Connecting via the geoportal. In a web browser, go to City and County of Honolulu’s (CCH) geoportal: 
https://honolulu-cchnl.opendata.arcgis.com/ 
 
• In the Search Data and Apps text box: Search for State Owned Land then click on it to go to the data 

page. 

 

https://opengislab.com
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• Click the APIs drop down arow >> Copy the URL for GeoService (CTRL + C). The web service only 

provides 2 options (both ESRI/ArcGIS service, no OGC options; see tip below) 

 
 

• In QGIS >> Browser Panel >> ArcGIS Feature Service >> New Connection 
 

 
 
You should now have two ArcGIS Feature Service Connections: 

 

TIP: If the service is OGC WFS or OGS WMF you will use the corresponding service connection tool in QGIS.  

https://opengislab.com
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10 WORKING WITH VECTOR DATA 
With QGIS you can view various spatial data formats, such as shapefiles, geopackages, spatialite, ESRI 
geodatabase (gdb), geojson, PostGIS database, and so on. One thing I like about QGIS is it can view a zipped 
shapefile and other zipped file formats. In this section, you will add in a shapefile of the UHM building footprints, 
symbolize the buildings by their use, create and edit a campus boundary layer based on the CCH State Owned 
Land web service, and then create a point layer from a  text file that represent trees on campus planted by 
Botanist, Joseph Rock in 1920.  

 SYM BO LIZ ING  BUILDING  FOO TPR INTS BY USE 
 

1. Optional: In the Brower Panel, find the path where you downloaded the workshop data (e.g. 
C:\Temp\QGIS_Workshop), right click on the folder >> Add to Favorites. 
 

2. In the Browser Panel, go to your QGIS_Workshop\SHP folder >> double click on UHM_BldgsFP.shp (or 
you can drag and drop the shp into the Layers Panel). This will add the building footprints shapefile to 
your map. 

 

https://opengislab.com
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3. Open the attribute table and view the information associated with the building footprints. In the Layers 
Panel, right click the layer name >> Open Attribute Table. Close the table when done viewing. Take note 
of the PROP_TYPE field – this is the field you will map 
 

 
 

4. Notice how the footprints are displayed in a single default color. Lets’ change the symbology of the 
buildings so they are color coded or categorized by their use or property type field. 
 

• Right click the layer name >> Properties (you can also double click the square symbol next to the 
layername as a shortcut). 

• Go to Symbology >> Switch from Single Symbol to Categorized 
• Value: select PROP_TYPE field 
• Color Ramp: can use random colors or select a preset color scheme 
• Click Classify button 
• Click OK 

 

 
 
 
 

https://opengislab.com
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Your map should now look something like this: 
 

 

Don’t forget to save your map 
 

5. Add a basemap to provide location context for where the buildings are. You may choose to use 
whichever basemap you like. Here, the example is using ESRI Topo. 
 

• Click on the QuickMapServices button >> ESRI >> ESRI Topo 
 

 
 

https://opengislab.com
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6. Change transparency and/or rendering of the building footprints so you can see it overlaid on top of the 
basemap.  

• Open the Properties window of the footprints layer (hint: double click on the symbol next to the 
layer name) 

• Play around with the different rendering options 
 

 
 

Here is an example using the following rendering options: 93.6% Transparency, Blending Mode = Burn 

 

https://opengislab.com
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 CREA TE A  UHM CAM PUS BO UNDA RY  US ING STATE O WNED PAR CE LS 
 
In this section you will create a campus boundary layer based on the State owned parcels layer from the CCH 
WFS. First, you will export the parcels of interest from the WFS, then you will edit this exported layer to create 
the UHM campus boundary. 
  

1. In the Browser Panel, go to CCH - StateOwnLands WFS service that you connected to earlier and add the 
State Owned layer to the Layers TOC. 
 

 
 

Notice how the State Owned layer is added to the top of layer list. This makes it hard to see the 
footprints that’s below the State Owned lands. Layers in the TOC are drawn from bottom up. 

You can do 2 things here:  
• Drag and drop the footprints layer to be display on top of the State Owned lands 
• Change the symbology of the State Owned lands to show as an outline, or 

 
2. Use the Select button >> Select the State Owned parcels that corresponds to the campus boundary 

• Make sure the State Owned layer is selected (highlighted) in the Layers TOC 
• Click the Select button 
• On the map, click on the polygons of interest to select them (use Crtl + click) 

 

 

https://opengislab.com
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3. With the polygons of interest from the State Owned layer selected (highlighted in yellow), right click the 

layer name >> Export >> Save Selected Feature As.. 
 
In the window, fill in your options. Here I am saving the selected features as a shapefile called 
CampusBoundary 
 

 
 
Your campus boundary layer should be added to your map. Turn off the footprints layer, notice there 
are many parcels that make up the campus area, lets fix this so what we have is clean polygons. 

 

https://opengislab.com
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4. Make sure CampusBoundary is the selected layer in the Layers TOC, then click the Toggle Editing button 

(pencil icon). Tip: the layer you’re currently editing should have a pencil icon next to it. 

 
 
Lower Campus Area: Using the Select Features button, select polygons A, B, C making up lower campus 
portion. 
  

 

With the polygons selected, go to the Edit menu >> Merge Selected Features.  Click OK to the popup 
that comes up. 

Noticed polygons A, B, C are merged but there are still “holes” in Polygon C that needs to be closed. 

 

https://opengislab.com
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Select the polygon, go to Edit menu >> Delete Ring. Then click on each of the Ring polygons (“holes”) to 
remove them. 

 

Don’t forget to save your edits and map 

Upper Campus Polygons: Following the steps above, fix the upper campus polygons. Merge polygons A, 
B, C, D, E then removed the rings/holes circles in black. 

 

Did you get “Merge Failed” error why trying to merge polygons A, B, C, D E?  In the lower right corner, 
click the message error log. Normally, the error log will give you some ideas as to what went wrong. But 
it seems like in this case it’s just a generic error message.   

 

I’m going to guess that this type of editing/geoprocessing error is that it’s something associated with a 
feature’s topology – mostly likely polygons B or C because these are “holes” in that might not be 
topologically correct.  

https://opengislab.com
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• Zoom in to the rings/holes of polygon B where Campus Center and Hemmingway Hall is. There is a 
possible topology error at a shared vertex between ring A and B – are they separate rings or one ring 

 

Try removing rings/holes in the polygons first before we merge them. 

• Select Polygon C, then go to Edit menu >> Delete Ring. 
• Click on the Ring/hole with the possible topology error (it would seem that rings A and B that 

look like 2 separate parts are actually a single ring)  
• Continue removing rings from all the polygons 
• Merge the polygons for the upper campus portion 
• Save your edits and map 
• Toggle the Edit button to stop editing 

Your campus boundary should now look like this: 

 

 CREA TE PO INT  LA YER  RE PR ESE NTING TR EES FR OM A TEX T FILE   
 
In this section, you will create a point layer from a text file that represent trees on campus planted by Botanist, 
Joseph Rock in 1920. The text file contains the Scientific name, vernacular or common name, picture (if 
available), description, and the latitude and longitude for the trees.  

https://opengislab.com
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1. Open the CampusTrees_Rock1920.txt file with Notepad and take a look at what in the file. Notice that it 
is comma delimited 

 

2. In QGIS, go to Layer Menu >> Add Layer >> Add Delimited Text Layer 
In the Data Source Manager window: 

• File name: Browse to CampusTrees_Rock1920.txt 
• Layer name: change or leave as default (CampusTrees_Rock1920) 
• File format: CSV (comma separated values) 
• Record and field options: Check First record has field names and detect field type 
• Geometry definition: X field = Long, Y filed = Lat; CRS = EPSG 4326 
• Click Add then Close 

 

A point layer should now be added to your map. Feel free to change the symbols if you want. 
 

3. The point layer that is added to your map is a virtual layer. If you save your map document then the 
settings used to display the text file info as points are saved. If you want to create a permanent point 
feature layer, just right click the layer name >> Export >> Save Features As.  

https://opengislab.com
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4. Optional – Display picture of the trees in a popup box. In the Layer Properties window: 
• Go to Display then in the HTML Map Tip, type in the following 

<img src=[% PIC1 %] width="350" height="250"> 
• Click OK 

 
NOTE: The PIC1 field contains the public URL link to the picture of the tree if available.  

• Click the Popup Tip button then hoover your mouse over a point and picture (if available) will be 
displayed 
 

 

https://opengislab.com
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11 WORKING WITH RASTER DATA 
In this section, you will be working with raster data. You will visualize a 2 different Digital Elevation Models 
(DEM): a Digital Surface Model (DSM) and a Digital Terrain Model (DTM). A DSM represents everything on the 
earth surface including buildings, trees, etc. A DTM represents the bare ground or earth. Then you’ll derived a 
normalized DSM (nDSM) by subtracting the DTM from the DSM. Elevation values from the nDSM are then 
extracted and added to the building footprints. Once the estimated height is obtained from the nDSM, you will 
then create a simple 3D building model.  

 VISUA L IZ ING  A  DSM A ND DTM   
 

1. Add in the DSM and DTM from the UHM_DSM and UHM_DTM folders  
 

2. Create a hillshade for the DSM. Right click on layer name >> Properties.  
• Go to Symbology tab 
• Render Type: Hillshade 
• Check Multidirectional 
• Leave other settings as default 
• Click OK 

 

 
 

3. Visualize the DTM as a single pseudocolor. Right click layer name >> Properties 
• Go to Symbology tab 
• Render Type: Singleband pseudocolor 
• Color Ramp: Select a color scheme 
• Leave other settings as default 
• Go to Transparency tab: Change transparency to 50% or whatever you like 

https://opengislab.com
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• Click OK 
 

 
 
Here the DTM (50% transparency) is shown on top of the DSM  

 

https://opengislab.com
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 DE RIVE NO RMALIZE D DEM (NDEM) FROM  THE DSM A ND DTM 
 
To derive a normalized DEM, subtract the DTM from the DSM (DSM-DTM = nDSM). This is essentially 
removing the effects of topography (terrain relief) on the elevation value of the buildings in the DSM. In 
this step you will use a raster calculator – which requires that the DSM and DTM are in the same 
coordinate system and have the same extent and cell size. 

 
1. Open Layer Properties window of the DSM. Right click layer name >> Properties 

 
• Click the Information tab and take notice of the CRS, Units, and Pixel Size.  

CRS: Unknown CRS: BOUNDCRS[SOURCECRS[PROJCRS["NAD83(HARN) / UTM zone 4N" (even though 

there is a CRS defined, it says Unknown CRS. This sometimes will happen and you’ll need to explicitly tell QGIS 
what the CRS is) 
Units: Meters 
Pixel Size: 1, -1 (disregard the negative number) 

• Click the Source tab and set the CRS for the layer to EPSG: 3750 (NAD83 (HARN)/UTM Zone 4N). 
Click OK. 

 
 

 
 

2. Do the same thing to define the CRS for the DTM layer 
 

3. Go to the Raster menu >> Raster Calculator 
• Double click on UHM_DSM@1 (this is fill in the math expression) 
• Click minus sign 
• Double click on UHM_DTM@1 

https://opengislab.com
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• Output layer: save as nDSM 
• Output format: save as Geotiff 
• Output CRS: make sure it’s EPSG: 3750 
• Check box to add result to project 
• Click OK 

 

 

 REPR OJECT BUILDING  FOO TPR INT LAYE R  
 
Before we extract the elevation value from the nDSM to the building footprints, we need to make sure the 
building footprint layer is also in the same coordinate system as the nDSM. If you view the CRS of the building 
footprints, it’s EPSG: 3760 – NAD83 (HARN)/Hawaii Zone 3 (ftUS), whereas the CRS of the nDSM is EPSG: 3750.  
 

1. Go to Vector menu >> Data Management Tools >> Reproject Layer 
 

 

https://opengislab.com
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2. In the Reproject Layer window: 
• Input Layer: UHM_BldgsFP [EPSG:3760] 
• Target CRS: EPSG:3750 – NAD83(HARN)/ UTM zone 4N 
• Reprojected: Click the … button >> Save to File >> Save the reprojected file as a shapefile and 

give it a name (e.g BldgsFP_NAD83HARNZ4M.shp) 
• Open output file after running algorithm  
• Click Run 

 

 

 EX TRA CT HEIG HT FROM  THE  NDSM TO  THE BUILD ING FOO TPR INTS 
 

1. Display the Processing Toolbox (cog wheel icon) menu. In the Toolbox, search for zonal statistics and 
then double click on the tool zonal statistics 
 

 
 

2. In the Zonal Statistics window: 
• Raster layer: nDSM [] 
• Raster Band: leave as default 
• Vector layer containing zones: Bldgs_FP_NAD83HARNZ4M (this is your reprojected layer) 

https://opengislab.com
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• Output column prefix: height_ 
• Statistics to calculate: click the …button then select Min, Max, Mean 
• Click Run 
• Check the Log tab to see if processing ran successfully 
• Click Close 

 

3. Open the attribute table of the BldgsFP_NAD83HARNZ4M layer and you should see that the hght_mean, 
hght_min and hght_max fields contain the values of height in meters for each building footprint. 
 

 

 VIEW/EXTR UDE THE  BUILD ING FOO TPR INTS TO 3D 
 
Now that we have the height of the building footprints, we can create a 3D view. The 3D view can be a little 
buggy sometimes, so save your work often. Also keep in mind that doing anything 3D can take a lot of 
computing power and a good graphics card, so it depends on your system setup. There is also a 3D viewer plugin 
called Qgis2threejs that you can install as well – this plugin gives a bit more options and can be used to export 
3D scenes to the web. 
 

1. Enable 3D view on the building footprints. Right click layer name >> Properties.  
 

https://opengislab.com
https://qgis2threejs.readthedocs.io/en/docs/index.html


   

29 

2. Go to 3D View tab, and set the options for 3d viewing: 
• Height: can leave as height  
• Extrusion: click the variable button >> Field Type >> Hght_max 
• Altitude clamping: Terrain 
• Altitude binding: Vertex 
• Shading: choose different shading if you want 
• Edges: check the box to display if you want outline of building faces 

 

 
 

3. Go to View Menu >> New3D Map View. A new window should pop up. You can dock the window 
anywhere you want. Use your mouse or the navigation compass to navigate. 

 
Here is an example of my 2D and 3D map views: 

 

https://opengislab.com
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12 BASIC MAP LAYOUT 
This section goes over how to make a basic map layout and export it to a pdf. Although there are cartographic 
principles, map making is a subjective process; there are no hard and fast rules so use this section as a guidance 
on how to make a basic map layout. See the QGIS help manual (Help menu >> Help Contents) for details on all 
the various settings/options Also, keep in mind making a professional looking makes takes time and patience.  

1. Go to Project menu >> New Print Layout 
• Create Print Layout Title: Give your map a title (e.g. UHM Campus Map) 
• A new Map Layout window opens – notice the default map size or page size is A4 and in mm 

units 
2. Go to Add Item menu >> Add Map. Then with your mouse, draw a box where you want the map frame 

to be 
• If you don’t see something in your map layout (i.e. footprints), click the button set map extent to 

main map canvas 

 
 

3. Go to Add Item menu >> Add 3D Map. Draw a box where you want your 3D map to be displayed. If you 
don’t see anything, Click the button, Copy Settings from a 3D View and select 3D Map 1. 
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4. To change a map item’s settings or properties, select the item whose properties you want to change. 
Then go to Item Properties tab and make your changes. Here is an example where a frame is added to 
the 3D map. 

 
 

TIP: You can change the name of the item by double clicking to get a text cursor then type in new name 
(e.g. Map 1 to 2D Map) 
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5. Use the Add Label button to add in a map title and any other options you want for the title 

 

 
 

6. Use the Add Legend button to add a legend to the 2D map. Draw a box inside the 2D map layout. Notice 
the default legend option shows all layers for the map. Uncheck the Auto update button if you want the 
remove items for the legend 
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TIP: Changing layer names in the QGIS Main will be reflected in the Legend if Auto Update Legend is 
checked. 

 
7. Add in a north arrow, using the North Arrow button. In the Item Properties, click the Arrows folder for 

SVG image, then select an arrow to use – there’s not many options. 
 

 
 

8. Add in a scale bar using the Scale Bar button. Change the scale bar’s item properties as you like. 
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Here is an example of a map layout: 

 
Here is another example with the ESRI Topo basemap turned on/display.  

Hints:  
• Go to QGIS Main >> Turn on ESRI Topo if not displayed.  
• Back in Map Layout, Select the 2D map item >> Click Refresh button.  
• Select the 3D Map 1 then click Copy Settings from a 3D View.  
• Fix the legend. Select the Legend in the map layout >> Uncheck the Auto Update box 

under Legend Items, then remove ESRI Topo and/or any other items you don’t want in 
the legend. 
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9. Export map to pdf or jpg. The Layout menu has a few options for saving your map layout. Go to Layout 

menu >> Export as PDF, Export as Image, or Export as SVG.  
 

 
 

• You may get a message about WMS not being printed if it exceed size limit. Click OK 
• Give file a name 
• In the PDF Export Options, choose your options 
• Click Save 
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Here is an example of an exported pdf. Note it is a layered pdf. 

 

13 BASIC WEB MAPPING - OPTIONAL 
You can make a quick web map by using the qgis2web plugin to create a quick web map in Leaflet, OpenLayers, 
Mapbox GL JS. Not coding knowledge is required unless you want to customize the maps beyond the basics. See 
the qgis2web github page for more info. 

1. Install qgis2web plugin from the Plugins menu 
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2. Click the qgis2web button then in the Export to web map window, use the tabs to set up or adjust the 

default settings and preview the map. 

 

• In the Export tab, export to folder and specify your output folder – this would be the folder you copy 
to put onto a web server to serve your map over the web 

• Click Export when done making changes 

 

When it finishes export, the web map will open locally on your computer, like the example below: 
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These are the exported files you need to copy to a web server so your web map can be viewed on the web. 
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